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Safety Notices

CAUTION

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a CAU-
TION notice until the indicated con-
ditions are fully understood and 
met. 

WARNING

A WARNING notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the l ike 
that, if not correctly performed or 
adhered to, could resul t in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
ind icated cond itions are fully 
understood and met.

See also Appendix A, “Safety Information,” 
starting on page 55.
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Infiniium Z-Series Oscilloscopes—At a Glance

Table 1 Z-Series Oscilloscope Bandwidths, Sample Rates, and Memory Depths

Band wid th Sample rate Memory depth

2 channel 4 channel 2 channel 4 channel Standard Maximum

DSAZ634A 63 GHz 33 GHz 160 GS/s 80 GS/s 50 Mpts 2 Gpts

DSOZ634A 63 GHz 33 GHz 160 GS/s 80 GS/s 20 Mpts 2 Gpts

DSAZ504A 50 GHz 33 GHz 160 GS/s 80 GS/s 50 Mpts 2 Gpts

DSOZ504A 50 GHz 33 GHz 160 GS/s 80 GS/s 20 Mpts 2 Gpts

DSAZ334A 33 GHz 33 GHz 80 GS/s 80 GS/s 50 Mpts 2 Gpts

DSOZ334A 33 GHz 33 GHz 80 GS/s 80 GS/s 20 Mpts 2 Gpts

DSAZ254A 25 GHz 25 GHz 80 GS/s 80 GS/s 50 Mpts 2 Gpts

DSOZ254A 25 GHz 25 GHz 80 GS/s 80 GS/s 20 Mpts 2 Gpts

DSAZ204A 20 GHz 20 GHz 80 GS/s 80 GS/s 50 Mpts 2 Gpts

DSOZ204A 20 GHz 20 GHz 80 GS/s 80 GS/s 20 Mpts 2 Gpts
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Ease of use with high performance

The Infiniium Z-Series oscilloscopes combine unprecedented ease of use with 
high-performance digitizing oscilloscope functionality to simplify your design and 
analysis measurement tasks.

• Traditional oscilloscope front-panel interface provides direct access to the 
controls needed for most troubleshooting tasks.

• User interface with menus, windows, dialog boxes, and toolbars provides easy 
access to dozens of configuration and analysis tools, ensuring you can set up 
and make the most complex measurements.

• All models offer 80 GSa/s sampling rate on all four channels. RealEdge models 
offer 160 GSa/s on two channels.

• Models with bandwidths from 20 GHz to 63 GHz.

Display shows waveforms and user interface
• User interface allows direct interaction with waveforms, including 

drag-and-drop positioning and instant waveform zoom.

• Large capacitive touch screen with multi-touch (gestures), handles, and 
resizing allows oscilloscope operation without an external pointing device.

• Waveforms are displayed in color, making correlation easy.

• Current configuration parameters displayed near the waveform display area are 
color-coded to make identification easy.

• Menus and toolbars simplify complex measurement setups.

Horizontal controls set sweep speed and position
• Zoom box on main sweep window makes it easy to see what will appear in the 

zoom window.

Acquisition and general controls start and stop the oscilloscope and do 
basic setup
• Run, stop, and single controls for continuous or single acquisitions.

• Clear display before one or more acquisitions.

• Default setup and Autoscale set initial configuration.

Removable solid-state drive and USB 2.0 and 3.0 ports for saving and 
restoring setups and measurement results
• Store measurement displays for inclusion in reports and test setup guides.

• Store oscilloscope setups to repeat tests another time.

• Hard disk stores oscilloscope operating system.

Trigger setup controls set mode and basic parameters
• Select Edge, Glitch, or Advanced Modes.

• Choose input source and slope.
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• Use auxiliary trigger to increase triggering flexibility.

Vertical controls set attenuation and position
• Color-coded knobs make it easy to find the controls that affect each waveform.

Marker and quick measurements help measure waveform parameters
• Use waveform markers 1 and 2 to check voltage or Δ-time at any point on the 

displayed waveform.
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In This Guide
This guide provides the information you need to begin using the Infiniium Z-Series 
oscilloscopes. 

Chapter 1, “Setting Up the Oscilloscope,” starting on page 11 includes power and 
air flow requirements, plus other setup information.

Chapter 2, “Using the Oscilloscope,” starting on page 25 gives an overview of the 
front and back panel inputs and outputs, front-panel controls, and user interface, 
and tells you how to perform basic operations with the oscilloscope.

Chapter 3, “Online Help and Other Information,” starting on page 51 describes the 
Infiniium oscilloscope application’s online help contents and online demos. The 
online help describes how to use the Infiniium oscilloscope application in detail.

Appendix A provides safety information in English and French. 

Appendix B provides recommendations for working comfortably and safely while 
operating the Infiniium oscilloscope.

For More Information
• For detailed information on how the oscilloscope makes measurements and 

how to use the oscilloscope, see the Infiniium oscilloscope application’s online 
help.

• For information on controlling the oscilloscope from a remote computer, see 
the Oscilloscopes Programmer’s Reference found in the Infiniium oscilloscope 
application’s online help.

• For information on testing and servicing the oscilloscope, see the Service Guide 
found in the Infiniium oscilloscope application’s online help.
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This chapter shows how to set up your Infiniium oscilloscope, connect power and 
accessories, and verify general operation.
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1 Setting Up the Oscilloscope
 

Inspecting Package Contents

✔ Inspect the shipping container for damage.

• Keep the shipping container or cushioning material until you have inspected 
the contents of the shipment for completeness and have checked the 
oscilloscope mechanically and electrically.

• If the shipping container is damaged, or the cushioning materials show signs 
of stress, notify the carrier and your Keysight Technologies Sales Office. 
Keep the shipping materials for the carrier’s inspection. The Keysight 
Technologies Sales Office will arrange for repair or replacement at 
Keysight’s option without waiting for claim settlement.

✔ Inspect the oscilloscope.

If there is mechanical damage or a defect, or if the oscilloscope does not 
operate properly or does not pass performance tests, notify your Keysight 
Technologies Sales Office.

✔ Verify that you received the following items in the Infiniium oscilloscope 
packaging.

• Infiniium oscilloscope

• Power cord

• Keyboard

• Mouse (USB optical)

• Front panel cover

• Calibration cable (the 50 GHz and 63 GHz bandwidth models include a 
second calibration cable for the RealEdge inputs)

• Connector savers (quantity of 5 for 20 GHz, 25 GHz, and 33 GHz bandwidth 
models; additional 2 for 50 GHz and 63 GHz bandwidth models)

• ESD wrist strap

• Quick Start poster

If anything is missing, contact your nearest Keysight Technologies Sales Office.

✔ Verify that you received the options and accessories you ordered and that none 
were damaged.

For a complete list of options and accessories available for the Z-Series 
oscilloscopes, see the Infiniium Z-Series Oscilloscopes Data Sheet.

http://cp.literature.agilent.com/litweb/pdf/5990-9712EN.pdf
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Environmental Characteristics

Table 2 Z-Series Oscilloscope Environmental Characteristics

Environment Indoor use only.

Ambient Temperature Operating: 5 °C to + 40 °C
Non-operating: –40°C to +65 °C

Humidity Operating: up to 95% relative humidity (non-condensing) at +40 °C
Non-operating: up to 90% relative humidity at +65 °C

Altitude Operating: up to 4,000 meters (12,000 feet)
Non-operating: up to 15,300 meters (50,000 feet)

Installation/ Measurement 
Category

Installation category: 2
Measurement category: 1

Weight 71 lbs 

Dimensions 20 in. wide (50.8 cm), 13.3 in. tall (33.8 cm), and 19.4 in. deep (49.3 
cm)

Safety CAN/CSA-C22.2 No. 61010-1-04
UL Std. No. 61010-1 (2nd Edition)

Voltage Fluctuations Note that the main supply voltage fluctuations are not to exceed 
±10% of the nominal supply voltage.

Pollution Degree The Infiniium Z-Series oscilloscopes may be operated in 
environments of Pollution Degree 2.

Pollution Degree 
Definitions

Pollution Degree 1: No pollution or only dry, non-conductive pollution occurs. 
The pollution has no influence. Example: A clean room or climate controlled 
office environment.
Pollution Degree 2. Normally only dry non-conductive pollution occurs. 
Occasionally a temporary conductivity caused by condensation may occur. 
Example: General indoor environment.
Pollution Degree 3: Conductive pollution occurs, or dry, non-conductive 
pollution occurs which becomes conductive due to condensation which is 
expected. Example: Sheltered outdoor environment.
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1 Setting Up the Oscilloscope
 

Positioning for Proper Airflow

1 Position the oscilloscope where it will have sufficient clearance for airflow 
around the back and sides. If you plan to connect multiple Infiniium 
oscilloscopes together, refer to the Keysight MultiScope Hardware 
Configuration Guide for airflow requirements.

Figure 1 Positioning the Z-Series Oscilloscope with Sufficient Clearance

Front panel of 
oscilloscope

Minimum 100 mm Minimum 100 mm

Minimum 39 mm

Top View

Rear Panel

Top: Minimum 0 mm

Bottom: Minimum 0 mm

CAUTION Do not place the oscilloscope side-by-side with other instruments blowing warm air. 
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Connecting a Mouse, Keyboard, and LAN Cable

A mouse and keyboard can be plugged into the USB host ports. Four host ports 
are on the rear panel, with two more on the front panel.

Connect your LAN cable to the RJ-45 connector on the back panel of the 
oscilloscope.

NOTE After you have connected to the LAN card, you must set up the network. Exit the oscilloscope 
application before you start setting up your network.

If you do not know how to set up a network in the Windows 7 operating system, see your 
network administrator or use the Windows 7 operating system’s online help.

Figure 2 Back Panel

CAUTION:  Power down
instrument before
insertion or removal
of hard drive.  

Removable
Hard Drive 

N10149

~ Line
1350W Max

100 - 240V
50/60 Hz

10 MHz inTrig Out 10 MHz out 100 MHz in 100 MHz out

CAUTION: Use only with 
power cable specified by 
owner’s guide.

WARNING: Maintain
ground to avoid electric
shock.

Aux Trig

169323

 Device

NOTICE
Well-regulated power
required for 100-120V
operation.

Mouse and keyboard connectors
(USB host ports) LAN connector

AC power cord 
plugs into here

Power Supply
LEDs
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1 Setting Up the Oscilloscope
 

Connecting Power

1 Connect the power cord to the rear of the oscilloscope, then to a suitable AC 
voltage source.

Table 3 Power Requirements

Power 100 - 240 VAC ±10% at 50/60 Hz
Maximum input power: 1350 Watts
Well-regulated power is required for 100-120 VAC operation

CAUTION Use Supplied Power Cord

Use only power cords designed for your oscilloscope.

The power cord provided is matched to the country of origin of the order.

WARNING Properly Ground the Oscilloscope

To avoid electric shock, be sure the oscilloscope is properly grounded.

NOTE Note that the oscilloscope’s power supply has a built-in safety feature that, after the 
oscilloscope is turned off, requires the oscilloscope to remain off for about 10 seconds before 
it is turned back on.
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Power Supply Protection Features

The Z-Series oscilloscope’s power supply has built-in protection features for 
over-voltage, over-current, and over-temperature fault conditions. Figure 2 
identifies the power supply LEDs and Table 4 describes their conditions.

When the over-voltage fault occurs (and the power supply shuts down), you must 
unplug the power cord, wait 30 seconds, and plug the power cord back in to reset 
the protection latch and allow the oscilloscope to be powered-on again.

When the over-temperature fault occurs, the temperature must drop below 110 °C 
before you can power-on the oscilloscope again.

Connecting Oscilloscope Probes

The Infiniium Z-Series oscilloscope channel 1-4 inputs have:

• 3.5 mm threaded RF connectors (like Keysight sampling oscilloscopes) to 
ensure the most reliable signal integrity.

• A convenient automatic torque mechanism that ensures a consistent 8 in-lbs 
connection.

• An AutoProbe II interface connector with pins that provide probe power, 
identification, and other communication signals.

Table 4 Power Supply LED Meanings

AC LED DC/FLT (Faul t) LED Cond ition

Green Green Normal operation

Off Red Low or NO AC

Green Red Over-Voltage Protection

Green Red Over Current

Green Orange Thermo Alarm Warning

Green Red Fault Over-Temp

Green Red Remote On/Off

CAUTION Maximum Input Voltage

Do not exceed the maximum input voltage rating. Oscilloscope channels 1-4, 1R, and 
3R are rated for maximum input of ±5V including transients.
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1 Setting Up the Oscilloscope
 

The AutoProbe II interface works with the InfiniiMax III probing system. There are 
four different InfiniiMax III probe amplifiers ranging from 16 to 30 GHz. For more 
information, see Keysight InfiniiMax III Probing System Data Sheet.

Before using the InfiniiMax III probes, review the InfiniiMax III Probe Handling 
Guide included with the probes. These probes are ESD sensitive devices and there 
is a proper order for connecting probe amplifiers to the oscilloscope, probe heads 
to the device under test (DUT), and probe heads to the amplifier. You can also find 
the InfiniiMax III Probe Handling Guide on the Keysight web site 
(www.keysight.com) or with other Keysight oscilloscope probes documentation in 
the Probe Resource Center (www.keysight.com/find/prc).

The N5442A Precision BNC 50 Ω adapter lets you use an InfiniiMax I or II active 
probe with the Z-Series oscilloscopes.

Figure 3 Z-Series Oscilloscope Probe Connectors

http://cp.literature.agilent.com/litweb/pdf/5990-5653EN.pdf
http://www.agilent.com
http://www.agilent.com/find/prc
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Connecting Threaded RF Cables

You can connect threaded RF cables to the Infiniium Z-Series oscilloscope inputs.

For input channels 1 through 4, you can connect 3.5 mm threaded RF cables using 
the automatic torque “clutch” mechanism to ensure a consistent 8 in.-lbs. 
connection.

The Aux Out and Cal Out connectors also work with 3.5 mm threaded RF cables.

For RealEdge input channels 1R and 3R (on the 50 GHz and 63 GHz bandwidth 
models), you can connect 1.85 mm threaded RF cables using a torque wrench to 
apply the necessary 8 in.-lbs. of torque.

Tilting the Oscilloscope for Easier Viewing

Tabs under the front feet of the oscilloscope can be flipped out to tilt the 
oscilloscope.

Figure 4  Flip-Out Tabs Under Front Feet
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1 Setting Up the Oscilloscope
 

Turning On the Oscilloscope

1 Press the power switch in the lower left corner of the oscilloscope front panel.

After a short initialization period, the oscilloscope display appears. The 
oscilloscope is ready to use.

2 You can connect and disconnect probes and cables while the oscilloscope is 
turned on.
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Figure 5 Turning On the Oscilloscope
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Verifying Basic Oscilloscope Operation

1 Install the supplied connector savers to each channel input. Keysight 
recommends using the connector savers to protect the input connectors.

2 Connect one end of the 54916-61626 calibration cable to oscilloscope input 
channel 1.

3 Connect the other end of the calibration cable to the Cal Out connector on the 
front panel.

4 Press [Default Setup] on the front panel.

The display will pause momentarily while the oscilloscope is configured to its 
default settings.

5 Press [Auto Scale] on the front panel.

The display will pause momentarily while the oscilloscope adjusts the time/div 
setting and vertical scale. You should then see a square wave with about four 
cycles on screen and a peak-to-peak amplitude of approximately five divisions.

Figure 6 Verifying Basic Oscilloscope Operation
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1 Setting Up the Oscilloscope
 

If you do not see the waveform, make sure your power source is adequate, the 
oscilloscope is properly powered on, and the cable is connected securely to the 
channel input and to the calibration output.

6 Move the mouse around the mouse surface and verify that the on-screen 
pointer follows the mouse movement.

7 Press the [Touch] key on the front panel to turn on the touch screen. Press and 
hold your finger to the screen. A right-click menu appears, which verifies that 
the touch screen is working properly.

Installing Application Programs on Infiniium

Infiniium has an open Windows operating system, which lets you install your own 
application software. Any application that runs on Microsoft Windows 7 Embedded 
and uses 8 GB of RAM or less may be installed on your Infiniium oscilloscope.

NOTE Exit the oscilloscope application before installing any software.

CAUTION Installing an application that does not meet these requirements may break the 
oscilloscope application and require a hard drive recovery.
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Changing Windows Operating System Settings

Many Windows operating system settings can be changed to suit your own 
personal preferences. However, some operating system settings should not be 
changed because doing so would interfere with the proper operation of the 
oscilloscope.

• Do not change the Power Options.

• Do not change the Language settings.

• Do not remove Fonts.

• Do not change the screen resolution from 1024 by 768 pixels.

• Do not use the Administrative Tools to enable or disable Internet Information 
Services. Use the Infiniium SCPI Server dialog box (Util ities > Remote...) to enable 
or disable the Web Server.

• Do not delete or modify the Infiniium Administrator user account.

NOTE Exit the oscilloscope application before changing any Windows operating system settings 
outside of the oscilloscope application.
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1 Setting Up the Oscilloscope
 

Turning Off the Oscilloscope

1 Press the power switch at the lower left corner of the oscilloscope front panel. 
The oscilloscope will go through a normal Windows operating system 
shutdown process.

Cleaning the Oscilloscope

Clean the oscilloscope with a soft cloth dampened with a mild soap and water 
solution.

CAUTION Do not use too much liquid in cleaning the oscilloscope. Water can enter the Infiniium 
panels, damaging sensitive electronic components.



25

 

Keysight Infiniium Z-Series Oscilloscopes 
User’s Guide

2 Using the Oscilloscope

Front Panel Inputs and Outputs 26
Back Panel Inputs and Outputs 29
Front Panel Controls (Keys and Knobs) Overview 31
User Interface Overview 32
Menu Overview 34
Using the Setup and Display Controls 35
Starting and Stopping Waveform Acquisitions 36
Adjusting the Horizontal Time Scale and Trigger Position 37
Adjusting the Vertical Settings 40
Setting Up Triggers 43
Using Markers and Making a Measurement 45
Saving and Printing Data 49
Forcing a Default Setup 50

This chapter describes how to use the Infiniium Z-Series oscilloscope’s inputs and 
outputs, front panel controls, and user interface.

• The familiar front-panel oscilloscope interface with knobs and keys is optimized 
for common tasks and basic measurements. 

• The Infiniium oscilloscope application’s user interface with menus, windows, 
dialog boxes, and toolbars provides easy logical access to dozens of 
configuration and analysis tools, making it easy for you to set up and make 
complex measurements. 

• You have the option of using either the front panel controls or the user interface 
for many common tasks.
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2 Using the Oscilloscope
 

Front Panel Inputs and Outputs

On the Infiniium Z-Series oscilloscopes, the channel inputs and the Aux Out and 
Cal Out outputs appear on the lower part of the front panel. The ground plug, probe 
compensation terminal, and two USB host ports are also located here.

Channel 1-4 Inputs

The channel 1-4 inputs have:

• 3.5 mm threaded RF connectors

• A convenient automatic torque mechanism

• An AutoProbe II interface connector with pins that provide probe power, 
identification, and other communication signals

The AutoProbe II interface works with the InfiniiMax III probing system. See 
“Connecting Oscilloscope Probes" on page 17.

You can also connect 3.5 mm threaded RF cables to the channel 1-4 inputs.

RealEdge 1R, 3R Channel Inputs

The [RealEdge] key and 1R and 3R channel inputs appear on 50 GHz and 63 GHz 
bandwidth models.

Pressing the [RealEdge] key enables or disables the RealEdge 1R and 3R channel 
inputs. The [RealEdge] key is lit when enabled.

Figure 7 Infiniium Z-Series Oscilloscope Front Panel I/O

1R 3R

Aux Out Cal Out

RealEdge

Figure 8 RealEdge Channel Inputs and [RealEdge] Key

1R 3RRealEdge
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When enabled, the RealEdge 1R and 3R channel inputs take over the standard 
channels 1-4, except for the trigger circuitry on channels 2 and 4. When RealEdge 
is enabled, you can still trigger on signals connected to the channel 2 and 4 inputs 
(but you cannot capture or display data from these signals).

You can connect 1.85 mm threaded RF cables to the RealEdge 1R and 3R channel 
inputs.

Ground

The ground plug is convenient for ESD wrist straps.

Aux Out

This output signal is selected by the Infiniium oscilloscope application's 
Calibration Output dialog box (Utilities > Calibration Output...). It can be a DC level, 
the probe compensation signal (a square wave used to adjust compensated 
passive probes), the trigger out signal, or a demo signal.

Cal Out

This calibration output is used when performing a user calibration on the 
oscilloscope.

A calibration cable is included with the oscilloscope. The 50 GHz and 63 GHz 
bandwidth models include a second calibration cable for the RealEdge channel 
inputs.

You can also use the Infiniium oscilloscope application’s Calibration Output dialog 
box (Utilities > Calibration Output...) to select other output signals, just like you can 
for the Aux Out output.

Probe Compensation Terminal

This terminal has a square wave signal that is used to adjust compensated passive 
probes.

You can also output a DC level on this terminal using the Infiniium oscilloscope 
application's Calibration Output dialog box.

USB Host Ports

Two USB host ports are located on the front panel, next to the power switch, for 
connecting peripherals.
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Front or Back Panel Inputs and Outputs

Trig Out and Aux Trig appear on the back panel in 50 GHz and 63 GHz bandwidth 
models of Z-Series oscilloscopes, and on models that have the optional sync port. 
They appear on the front panel in 20 GHz, 25 GHz, and 33 GHz bandwidth models.

Trig Out

Pulses corresponding to oscilloscope triggers can be sent to this BNC output.

Aux Trig

You can set up the oscilloscope to trigger on the auxiliary trigger signal connected 
to this BNC input.
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Back Panel Inputs and Outputs

The Infiniium Z-Series oscilloscope’s back panel has the motherboard I/O 
connectors and reference clock synchronization connectors. 

Motherboard I/O

The motherboard provides these inputs/outputs/ports in the oscilloscope: four 
USB ports for peripherals, an external monitor connector, USB III device port (for 
remote control of the oscilloscope from a PC), LAN port, and speaker and 
microphone connectors.

Figure 9 Infiniium Z-Series Oscilloscope Back Panel I/O
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10 MHz In, 10 MHz Out

The 10 MHz In BNC connector is used to synchronize the oscilloscope's horizontal 
timebase system to a reference clock that you provide. The clock that you provide 
must meet the following specifications:

• Amplitude: 178 mV peak to 1 V peak

• Frequency: 10 MHz ±5 ppm high-quality sine wave or square wave

To use a 10 MHz external reference clock, connect the external clock to the 
10 MHz In BNC connector; then, in the Infiniium oscilloscope application's 
Horizontal dialog box (Setup > Horizontal...), enable the 10 MHz External Reference 
Clock.

You can use the 10 MHz Out BNC connector to send the oscilloscope’s 10 MHz 
reference clock output signal to another instrument’s reference clock input.

100 MHz In, 100 MHz Out

The 100 MHz IN SMA connector is used to synchronize the oscilloscope's 
horizontal timebase system to a reference clock that you provide. The clock you 
provide must meet the following specifications:

• Amplitude: 178 mV peak to 1 V peak

• Frequency: 100 MHz ±5 ppm high-quality sine wave or square wave

To use a 100 MHz external reference clock, connect the external clock to the 
100 MHz In SMA connector; then, in the Infiniium oscilloscope application's 
Horizontal dialog box (Setup > Horizontal...), enable the 100 MHz External 
Reference Clock.

You can use the 100 MHz Out SMA connector to send the oscilloscope’s 100 MHz 
reference clock output signal to another instrument’s reference clock input.
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Front Panel Controls (Keys and Knobs) Overview

The Infiniium Z-Series oscilloscope front panel gives you direct access to the 
functions needed to perform the most common measurements, using a traditional 
oscilloscope interface. Knobs and keys let you directly set vertical and horizontal 
parameters. The front panel also has a set of LED indicators; by using these and 
the display, you see the oscilloscope’s configuration at a glance.

The oscilloscope uses color consistently throughout the front panel and user 
interface. For example, the color of the knob for channel 1 is the same color as the 
waveform for channel 1. All the configuration items and values related to channel 
1 are displayed in the same color.

Figure 10 Infiniium Z-Series Oscilloscope Front Panel

1R 3R

Aux

Run Control

Horizontal

Level
Trigger

Measure

Vertical

Position Touch Turn

Aux Out Cal Out

for Vernier

Push

Push

to Zero

Push
for Vernier

Push
to Zero

Push

(Push for 50%)

for Vernier

(Push to Toggle)

(Hold to Reset)

to Zero

Push

MenuSource Slope Sweep

Auto
Scale

Default
Setup

Clear
Display

Multi
Purpose

1

2

3

4

Run
Stop

Single

Print
Screen

Zoom

Touch

Short
CutMarkers

RealEdge

Digital Storage OscilloscopeDSO-X 96204Q 160 GSa/s62 GHz 

Horizontal controls

Trigger controls

Acquisition
Run controls

Measure controls

Vertical controls

Setup and
Display controls

Digital Storage OscilloscopeDigital Storage OscilloscopeDSO-Z 204ADSO-Z 204A 80 GSa/s80 GSa/s20 GHz 20 GHz Z-SeriesZ-Series



32 Infiniium Z-Series Oscilloscopes User’s Guide

2 Using the Oscilloscope
 

User Interface Overview

With the user interface for the Infiniium oscilloscope, you can access all the 
configuration and measurement features of the oscilloscope through an 
easy-to-use system of windows, menus, toolbars, dialog boxes, icons, wizards, 
and buttons.

The user interface is arranged so the most common functions affecting the 
waveform display are located around the edge of the waveform display area. 

Context-sensitive menus are available when you right-click something in the 
waveform display area, such as the grid, a signal, a bookmark, or a measurement. 
You can mouse over or touch other areas, such as the drag & drop measurements 
area and horizontal and acquisition control regions, to find more information about 
those areas or to enter data. 

The following figures call out the areas and controls of the user interface.

Figure 11 Infiniium Oscilloscope Top of Display

The selected grid mode in the upper right corner determines whether you draw a selection box or drag 
a waveform horizontally when you touch the screen.
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The waveform display area shows up to eight waveform areas. Several display 
options are available, such as grids or horizontal and vertical scales. 

Ground reference indicators appear for each displayed channel, waveform 
memory, or math function waveform. The symbol represents the ground reference 
point for each waveform; it moves when you change the vertical offset. You can 
also drag this symbol up and down to change the vertical offset for that waveform.

Figure 12 Infiniium Oscilloscope Waveform Display Area
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NOTE Avoid Overdriving Vertical Input Amplifiers

When zooming on a waveform with the oscilloscope running, be careful to keep the signal 
within the screen vertically to avoid overdriving the vertical input amplifiers. Overdriving 
causes waveform distortion and erroneous measurement results. 
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A Results pane is visible at the very bottom of the display when you do something 
that requires it, such as take a measurement. When it is not needed, the Results 
pane is not visible.

Menu Overview

You can use menus to perform defined operations, set up measurement 
parameters, and access every function the oscilloscope provides. 

Take a few minutes to look through the menus to get an overview of the many 
features and capabilities of your Infiniium oscilloscope.

The menu selections will vary slightly, depending on which licenses are installed.

Figure 13 Infiniium Oscilloscope Bottom of Display
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Using the Setup and Display Controls

You can set the oscilloscope to a known starting condition and set the display to 
suit your preferences.

• To automatically configure the oscilloscope for the current input signal(s), press 
[Auto Scale] or click Control > Autoscale from the main menu.

• To enable or disable the touch screen, press the [Touch] key. Or, click Utilities > 
User Preferences... to open the User Preferences dialog box, and click the Enable 
Touch Screen check box.

• To remove acquisition data from the display, press the [Clear Display] key or 
click the Clear Display button .

The oscilloscope clears acquired waveform data from the display in preparation 
for another acquisition. If the oscilloscope is in Run mode and is receiving 
triggers, it will update the display as it collects new waveform data.

Clearing the waveform display also resets measurements, averaging, infinite 
persistence, color grade persistence, histograms, and the mask testing 
database.

• To reset the oscilloscope to its default setup, press [Default Setup] or click 
Control > Default Setup.

You can click Control > Undo Default Setup to return the oscilloscope to its 
original configuration.

Figure 15 Setup and Display Control Keys
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NOTE Save the Current Oscilloscope Configuration

Before using the default setup, you may want to save the current oscilloscope configuration 
for later use. See the online help (described in chapter 3) for instructions on saving and 
recalling setups, and for information on the exact configuration that is set when you use the 
default setup.
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Starting and Stopping Waveform Acquisitions

Use the acquisition run controls to run and stop acquisitions or make a single 
acquisition. The boxed area of the memory bar above the waveform display area 
shows which portion of the channel’s acquisition memory you are viewing. 

The [Run/Stop] key is lit green and the green Run button is highlighted when the 
oscilloscope is running (acquiring data). The [Run/Stop] key is red and the Stop 
button is highlighted when the acquisition is stopped. 

• To start waveform acquisition, press the [Run/Stop] key or click the Run button.

The oscilloscope begins acquiring data. When it receives a trigger signal, it 
finishes acquiring data, updates the display, and then starts another acquisition 
cycle if it is in Trig’d or Auto trigger mode.

• To stop waveform acquisition, press the [Run/Stop] key or click the Stop 
button.

The oscilloscope stops acquiring data. Whatever data was last acquired 
remains on the screen.

• To make a single acquisition, press the [Single] key or click the Single button.

• You can also choose the Run, Run Single, and Stop commands from the Control 
menu.

• To set up how you want the signals to be sampled, such as sampling rate and 
mode, click Setup > Acquisition....

Figure 16 Acquisition Run Control Keys and Buttons
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Adjusting the Horizontal Time Scale and Trigger Position

Use the horizontal controls to configure the oscilloscope’s horizontal scale (time 
per division) and horizontal position of the waveform. You can view a magnified 
section of the waveform using the zoom window.

Use gestures on the touch screen to adjust the waveform horizontal scale and 
position. You can also use the horizontal knobs, the horizontal controls, or the 
Horizontal dialog box.

Figure 17 Front Panel Horizontal Scale and Position Knobs, [Zoom] key

Figure 18 User Interface Horizontal Controls
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Adjusting the horizontal scale

The horizontal scale knob is the larger of the two horizontal control knobs, marked 
with a set of sine wave symbols. 

• To stretch the waveform horizontally, turn the horizontal scale knob clockwise. 
To shrink it horizontally, turn the knob counter-clockwise.

Stretching the waveform means fewer seconds are displayed per division. 
Shrinking it means more seconds are displayed per division.

• Push and turn the horizontal scale knob to change the scaling in finer (Vernier) 
increments.

• Use the multi-touch gesture capability to stretch or shrink the waveform.

• You can also use the controls in the horizontal toolbar to adjust the horizontal 
scale. Mouse over or touch the horizontal scale field and use the resulting 
controls to set an exact horizontal scale. You can click the Scale field to enter an 
exact value, or click the “narrower” or “wider” buttons.

Adjusting the horizontal trigger position (delay)

The horizontal position knob is the smaller of the two horizontal control knobs, 
marked with a set of arrows. 

• To move the waveform to the right, turn the horizontal position knob clockwise. 
To move it to the left, turn the knob counter-clockwise.

Moving the waveform to the right shows more of the pre-trigger data (data 
acquired before the trigger event). Moving the waveform to the left shows more 
of the post-trigger data.

When you click and drag the desired waveform, the horizontal position will 
change for all channels and functions on the display. Waveform memories will 
also move if you check the Tie to Timebase box in the Waveform Memories 
dialog box.

• You can also use the controls in the horizontal toolbar to adjust the horizontal 
position. Mouse over the horizontal position field and use the resulting controls 
to set a particular horizontal position (time relative to the trigger at the 
highlighted horizontal reference point). 

Magnifying a part of the waveform using Zoom

• To turn on zoom, press the  key or click the Zoom button.

The waveform display area splits into two regions. The top one is the main 
timebase. The bottom is the zoomed timebase, which represents an expansion 
of the acquired waveform data. A section of the waveform in the main timebase 
window is highlighted to indicate the part shown in the zoomed timebase 
window.
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The horizontal scale and horizontal position controls now change how the 
waveform is shown in the zoomed timebase window. The horizontal scale will 
change the amount of magnification, while the position will change the part of 
the waveform in the main window that is shown in the zoomed window.

• Press the  key or click the Zoom button again to turn off Zoom.

Setting the scale, position, and timebase reference

You can use the Horizontal dialog box to set scale, position, and timebase 
reference. You can also set up the zoomed timebase window.

• To access the Horizontal dialog box, click the  in the horizontal toolbar, or 
click Setup > Horizontal... from the menu bar.

• The Timebase Reference control is a slider from 0 to 100% of the screen. The 
center of the screen is at 50%. The slider correlates to the orange triangle at 
the bottom of the grid. 
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Adjusting the Vertical Settings

Use the vertical controls to set the vertical scaling (volts per division) and vertical 
offset. You can also turn the display on or off for a particular channel.

Figure 19 Front Panel Channel Keys and Vertical Scale and Offset Knobs

Figure 20 User Interface Vertical Controls
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Turning a channel on or off

• To turn channels 1 through 4 on or off, press the channel number key on the 
front panel or click the Additional Waveforms button  in the toolbar. When 
you turn off a channel, the current vertical scale and offset fields for that 
channel disappear.

• To change from 33 GHz inputs to 63 GHz inputs, press the RealEdge button on 
the front panel. Channels 1 and 3 become 1R and 3R. Channels 2 and 4 are not 
are used in RealEdge mode.

• If you are not using a particular channel, you can turn it off to simplify the 
waveform display and increase the display update rate. Functions continue to 
run on a channel source that is turned off. Data acquisition continues for a 
channel if a function requires it.

Adjusting the channel’s vertical scale and offset

You can use the vertical scale and offset knobs, the vertical user interface controls, 
or the Channel dialog box to adjust the vertical scale and offset. 

The vertical scale knob is the larger of the two knobs for a channel. It is marked 
with a set of sine wave symbols. 

• To make the waveform bigger (fewer volts per division), turn the vertical scale 
knob clockwise. To make it smaller (more volts per division), turn the knob 
counter-clockwise.

Decreasing the vertical scale makes the waveform bigger, and increasing it 
makes the waveform smaller.

• You can also mouse over or touch the vertical scaling field and use the resulting 
controls to set an exact value for the scaling.

The vertical offset knob is the smaller of the two knobs for a channel. It is marked 
with a set of arrows. 

• To move the waveform toward the top of the display, turn the vertical offset 
knob clockwise. To move it toward the bottom of the display, turn the knob 
counter-clockwise. 

• You can click and drag the waveform or its ground reference indicator to the 
desired vertical offset if the grid is in drag mode .

• Click Setup > Channel N... or click a channel number to open the Channel dialog 
box, in which you can set the vertical scale, offset, skew, and labels. You can 
also specify the characteristics of a probe, or perform a probe calibration.

NOTE Using a Channel as Trigger

Any channel can be used as a trigger source. If you need a trigger but do not need all 
channels, you can use a channel as a trigger without displaying it by turning the channel 
display off.
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For Keysight Technologies probes that are compatible with AutoProbe II 
interfaces, the oscilloscope will automatically set these characteristics (except 
for skew) after identifying the probe when it is connected to the channel input.
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Setting Up Triggers

Use the trigger controls to set the conditions on which the oscilloscope will trigger 
and acquire an input signal. You can set up a variety of trigger conditions. Edge 
triggers and the parameters for edge triggering can be set up from the front panel.

Trigger configuration settings you make using the user interface are reflected in 
the front-panel status indicators, and will remain set unless you change them or 
press the [Default Setup] key. 

Setting the oscilloscope to trigger on an edge

1 Press the [Source] key until the desired source LED is lit.

You can choose any of the channels or the Aux Trig or Line input as the source 
for an edge trigger.

2 Press the [Slope] key until the desired slope LED is lit.

You can have an edge trigger on a rising or falling edge, or both.

3 Press the [Sweep] key until the desired LED is lit (Trig’d or Auto).

When Trig’d is selected, the oscilloscope must find the trigger before capturing 
and displaying data.

When Auto is selected, if a trigger does not occur within a certain amount of 
time, an acquisition is automatically saved and displayed. In Auto trigger mode, 
you are able to see your signals while setting up the desired trigger.

4 Turn the Level knob to adjust the voltage level at which the oscilloscope will 
trigger.

Figure 21 Trigger Controls and Indicators
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Use the Trigger dialog box to select any of the different modes of triggering, the 
parameters and conditions for each trigger mode, and advanced configuration 
items.

You can also mouse over the Trigger Level field and use the resulting controls to 
set a particular trigger level when the scope is set for edge trigger on a particular 
channel. You can also drag the trigger reference indicator at the left side of the 
display.
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Using Markers and Making a Measurement

With the measurement controls you can display and adjust markers, define a key 
to perform automatic measurements or other quick actions, and make 
measurements.

Figure 22 Front Panel Measure Controls

Figure 23 Drag & Drop Measurement Toolbar
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Making a measurement on a waveform

Click and drag a measurement icon to the waveform event you want to measure, 
or click a measurement icon and specify which source you want to measure in the 
dialog box that appears.

For measurements on waveform features, such as those that involve waveform 
edges, if you click the measurement icon and specify a source, the measurement 
defaults to using the feature closest to the horizontal reference point. When you 
make the measurement using drag-and-drop, the measurement uses the 
waveform feature closest to the point where you drop the icon.

The most commonly used measurements are available in the drag and drop area. 
Others are available by selecting them from the Add Measurement dialog box.

When you drag and drop a measurement icon on a waveform, the icon outline 
changes color to match the color of each waveform it touches so you can easily 
see which waveform will be measured.

For edge-sensitive measurements, when you drop the measurement icon on a 
waveform, a circled number appears in the waveform marker color. This number 
shows exactly where the measurement is being made. It is displayed next to the 
measurement readout in the Results area.

This feature helps you distinguish measurement results from each other when you 
make multiple measurements on the same waveform, but at different waveform 
features.

Using quick measurements

• You can define the [Multi Purpose] key and Utilities > Multipurpose selection to 
perform one of these quick actions:

• QuickMeas—performs automatic measurements

• QuickPrint—prints the screen image to the default printer

• QuickScreen—saves the screen image to a file

• QuickSetup—loads a setup file

• QuickWaveform—saves waveform data to a file

• QuickEmail—sends an email of the current screen image

• QuickExecute—runs an executable file

• QuickControl—cycles through the possible front panel control sources

The action taken when the [Multi Purpose] key is pressed or Utilities > Multipurpose 
is clicked depends on the feature selected in the Customize Multipurpose dialog 
box (Utilities > Customize Multipurpose...). The default feature is QuickMeas.

• To turn on the quick measurement display, press the [Multi Purpose] key.
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The 10 preset measurements defined in the Quick Measurement configuration 
are enabled and results are displayed on the screen for the first waveform 
source. 

• To measure parameters for another waveform, press the [Multi Purpose] key 
until that waveform is the one shown in the measurement readout.

Continuing to press the [Multi Purpose] key cycles through each of the 
waveforms available.

• To turn off the quick measurement display, repeatedly press the [Multi Purpose] 
key until the measurements are turned off.

See the Infiniium oscilloscope application’s online help for information on how to 
configure the quick measurement capability.

Using markers

Markers make it easier to make precise measurements because the marker 
measurement readouts show exact voltage and time positions for the markers. The 
measurements are based on actual waveform data from the acquisition system, 
not on approximations based on the display position, so you can be sure the values 
are highly accurate.

Using the marker and measurement controls, you control two sets of markers 
within the oscilloscope grid. 

Both time and voltage differences between the markers are updated continuously 
on the screen. By default, the markers track the source waveform. Voltage 
measurements from the markers are the value of the waveform at the time set with 
the marker arrow keys.

• To select the type of marker mode you want to use, press the [Markers] key. 

• To turn on Marker 1 (X1), push the Position knob. Turn the knob to move the 
marker. Push the knob again to select Marker 1 (Y1).

Marker 1 (X1 and Y1) has a solid line pattern on the waveform display. It is 
associated with the first available source on the display.

• To turn on Marker 2 (X2), push the Position knob again.

Marker 2 has a dashed line pattern on the waveform display. It is associated 
with the first available source on the display.

• In Track Measurements mode, the marker position cannot be changed.

Moving markers using the user interface

1 Turn on the markers by clicking Measure > Markers... and selecting a mode. You 
can also click the Markers button  to either turn on markers or bring up the 
Markers dialog box.

2 Drag one of the markers to the position you want on the waveform.
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Dragging a marker makes it easy to quickly move the marker to the desired 
waveform event. You can use the front-panel Position knob for fine adjustment, 
or click Measure > Markers... and set the marker position precisely.
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Saving and Printing Data

• Click File > Save > to save your composite, setup, waveform, screen image, or 
measurement data.

• Click File > Copy Screen Image to easily copy and paste a screen image into a 
document.

• Click File > Print... to print waveform and setup data to a specified file.

• You can customize the [Multi Purpose] key to perform a QuickPrint.
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Forcing a Default Setup

If your Infiniium oscilloscope is not working properly when you start it up, follow 
these steps to perform a default setup and return the Infiniium to normal 
operation.

1 Click Control > Default Setup or press the [Default Setup] key.

2 If the oscilloscope is still not working properly, click Control > Factory Default to 
return the oscilloscope to the default settings it had when it left the factory.

3 If the oscilloscope is still not working properly, turn it off.

4 Turn the oscilloscope back on. If it does not successfully restart, try recycling 
the power again.

5 As soon as the Windows 7 load screen disappears, press [Default Setup]. If the 
oscilloscope still does not successfully restart, follow the instructions for 
recovering the hard drive.

Infiniium hard drive recovery

Follow these steps to recover your Infiniium hard drive.

1 Turn off the oscilloscope.

2 Connect the keyboard to the keyboard connector on the rear panel of the 
oscilloscope.

3 Connect the mouse to the mouse connector on the rear panel of the 
oscilloscope.

4 Turn on the oscilloscope.

5 As soon as you see the message press F2 to boot the Infiniium Recovery System, 
press [F2] and follow the on-screen instructions.

6 Once the recovery process is finished and the oscilloscope is running, check in 
the About Infiniium dialog box under installed options to see if all of the options 
you ordered are installed. If the options are not installed, please install them 
using the license keys provided on the oscilloscope option license certificates 
you received, or refer to the rear panel of the oscilloscope.



51

 

Keysight Infiniium Z-Series Oscilloscopes 
User’s Guide

3 Online Help and Other 
Information

Accessing the Online Help 51
Navigating the Online Help 53
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Most of the information about using the Infiniium oscilloscope effectively is 
included in the online help.

The online help is accessible from the menu bar and by clicking the question mark 
in the top right corner of dialog boxes. 

Accessing the Online Help

• Click Help > Contents....

The Using the Oscilloscope topic appears on the home page. It looks like the 
following figure.

Figure 24 Help Menu
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Figure 25 Online Help Home Page

NOTE Viewing the Online Help Window

The online help window always stays on top of the interface display, so you can refer to it 
while working with the oscilloscope. You can move the window around the screen or resize it 
to make it easier to use.
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• For information about items in a dialog box, click the Help button in that dialog 
box.

Navigating the Online Help

The online help provides several ways to find the information you need.

Use the Contents tab to browse topics in the help system by clicking topics in the 
left pane.

Use the Index tab to type in a keyword and search the index for that keyword or 
scroll through the list to find a topic.

Use the Search tab to type in a keyword and if that word exists in the online help, a 
list of topics containing the keyword appears.

Use the Favorites tab to add preferred help topics to a list for easy reference.

Using the Demo Wizard

Your Z-Series oscilloscope comes with a built-in demo wizard that showcases 
many of the oscilloscope’s capabilities. To see the demos, click Help > Show Demo 
Wizard.... You can then select a specific demo, such as a particular protocol or a UI 
demo showing bookmarks.

For example, the following screen display shows the initial demo page for the FFT 
function. To experiment with the demo, click Load Demo....

Figure 26 Help Button for Dialog Box Help
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Figure 27 FFT Demo
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English

The following general safety precautions must be observed during all phases of operation 
of this instrument. Failure to comply with these precautions or with specific warnings or 
operating instructions in the product manuals violates safety standards of design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer's failure to comply with these requirements. Product manuals are 
provided with your instrument on CD-ROM and/or in printed form. Printed manuals are an 
option for many products. Manuals may also be available on the Web. Go to 
www.keysight.com and type in your product number in the Search field at the top of the 
page.

General Do not use this product in any manner not specified by the manufacturer. The protective 
features of this product may be impaired if it is used in a manner not specified in the 
operation instructions.

Before Applying
Power

Verify that all safety precautions are taken. Make all connections to the unit before 
applying power. Note the instrument's external markings described in “Safety Symbols”.

Ground the
Instrument

If your product is provided with a grounding type power plug, the instrument chassis and 
cover must be connected to an electrical ground to minimize shock hazard. The ground pin 
must be firmly connected to an electrical ground (safety ground) terminal at the power 
outlet. Any interruption of the protective (grounding) conductor or disconnection of the 
protective earth terminal will cause a potential shock hazard that could result in personal 
injury.

Fuses See the user's guide or operator's manual for information about line-fuse replacement. 
Some instruments contain an internal fuse, which is not user accessible.

Do Not Operate in an
Explosive

Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Only qualified, service-trained personnel who are aware of the hazards involved should 
remove instrument covers. Always disconnect the power cable and any external circuits 
before removing the instrument cover.

Cleaning Clean the outside of the instrument with a soft, lint-free, slightly dampened cloth. Do not 
use detergent or chemical solvents.
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Do Not Mod ify the
Instrument

Do not install substitute parts or perform any unauthorized modification to the product. 
Return the product to an Keysight Sales and Service Office for service and repair to ensure 
that safety features are maintained.

In Case of Damage Instruments that appear damaged or defective should be made inoperative and secured 
against unintended operation until they can be repaired by qualified service personnel.

CAUTION A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, 
or the like that, if not correctly performed or adhered to, could result in damage to the 
product or loss of important data. Do not proceed beyond a CAUTION notice until the 
indicated conditions are fully understood and met.

WARNING A WARNING notice denotes a hazard. It calls attention to an operating procedure, 
practice, or the l ike that, if not correctly performed or adhered to, could resul t in 
personal injury or death. Do not proceed beyond a WARNING notice until the ind icated 
cond itions are fully understood and met.
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Safety Symbols
Table 5 Description of Safety related symbols that may appear on a product (Sheet 1 of 2)

Symbol Description

Direct current

Alternating current

Both direct and alternating current

Three phase alternating current

Earth ground terminal

Protective earth ground terminal

Frame or chassis ground terminal

Terminal is at earth potential

Equipotentiality

N Neutral conductor on permanently installed equipment

L Line conductor on permanently installed equipment

On (mains supply)

Off (mains supply)

Standby (mains supply). The instrument is not completely disconnected from the 
mains supply when the power switch is in the standby position

In position of a bi-stable push switch

Out position of a bi-stable push switch

Equipment protected throughout by DOUBLE INSULATION or REINFORCED 
INSULATION
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Caution, refer to accompanying documentation

Caution, risk of electric shock

Do not apply around or remove from HAZARDOUS LIVE conductors

Application around and removal from HAZARDOUS LIVE conductors is permitted

Caution, hot surface

Ionizing radiation

CAT I IEC Measurement Category I

CAT II Measurement Category II

CAT III Measurement Category III

CAT IV Measurement Category IV

Table 5 Description of Safety related symbols that may appear on a product (Sheet 2 of 2)

Symbol Description
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French

Les consignes de sécurité générales présentées dans cette section doivent être appliquées 
au cours des différentes phases d'utilisation de cet appareil. Le non-respect de ces 
précautions ou des avertissements et consignes d'utilisation spécifiques mentionnés dans 
les manuels des produits constitue une violation des normes de sécurité relatives à la 
conception, à la fabrication et à l'usage normal de l'instrument. Keysight Technologies ne 
saurait être tenu responsable du non-respect de ces consignes. Les manuels des produits 
sont fournis avec votre instrument sur CD-ROM et/ou en version papier. Les versions 
papier des manuels sont en option pour de nombreux produits. Certains manuels sont 
également disponibles en ligne. Pour y accéder, allez sur le site www.keysight.com et 
saisissez la référence de votre produit dans le champ Rechercher qui se trouve en haut de 
la page.

Général ités Utilisez ce produit uniquement dans le cadre prévu par le fabricant. Si vous ne respectez 
pas les instructions d'utilisation, les fonctions de sécurité du produit risquent d'être 
inhibées.

Avant la mise sous
tension

Vérifiez que vous avez bien respecté toutes les consignes de sécurité. Faites tous les 
branchements au niveau de l'appareil avant de mettre ce dernier sous tension. Tenez 
compte des marquages externes à l'instrument décrits à la section «Symboles de sécurité».

Mise à la terre de
l'instrument

Si une prise de mise à la terre est fournie avec le produit, le châssis et le capot de 
l'instrument doivent être reliés à la terre afin de limiter les risques d'électrocution. Le 
contact à la terre doit être solidement connecté à une borne de terre (de sécurité) au 
niveau de la prise de courant. Toute interruption du conducteur de protection (mise à la 
terre) ou tout débranchement de la borne de terre de protection donne lieu à un risque 
d'électrocution pouvant entraîner des blessures graves.

Fusibles Pour obtenir des instructions sur le changement des fusibles de ligne, consultez le guide 
de l'utilisateur ou le manuel d'instructions. Certains instruments comportent un fusible 
interne inaccessible à l'utilisateur.

Ne pas util iser en
atmosphère

explosive

N'utilisez pas l'instrument en présence de gaz ou de vapeurs inflammables.

Ne pas démonter le
capot de

l'instrument

Seules des personnes qualifiées, formées à la maintenance et conscientes des risques 
d'électrocution encourus sont autorisées à démonter les capots de l'instrument. 
Débranchez toujours le cordon d'alimentation secteur et tous les circuits externes avant de 
démonter le capot de l'instrument.

Nettoyage Nettoyez la partie externe de l'instrument à l'aide d'un chiffon doux et non pelucheux, 
légèrement humidifié. N'utilisez pas de détergents ou de solvants chimiques.

Ne pas mod ifier
l'instrument

N'installez pas de composants de remplacement et n'apportez aucune modification non 
autorisée à l'appareil. Pour toute opération de maintenance ou de réparation, renvoyez 
l'appareil à un bureau de vente et de service après-vente Keysight, afin d'être certain que 
les fonctions de sécurité seront maintenues.

En cas de
dommages

Les instruments endommagés ou défectueux doivent être désactivés et protégés contre 
toute utilisation involontaire jusqu'à ce qu'ils aient été réparés par une personne qualifiée.
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Symboles de
sécurité:

CAUTION La mention ATTENTION indique un risque. Si la manoeuvre ou le procédé correspondant 
n'est pas exécuté correctement, il peut y avoir un risque de dommages à l'appareil ou de 
perte de données importantes. En présence de la mention ATTENTION, il convient de 
s'interrompre tant que les conditions indiquées n'ont pas été parfaitement comprises et 
respectées.

WARNING La mention AVERTISSEMENT signale un danger pour la sécurité de l'opérateur. Si la 
manœuvre ou le procédé correspondant n'est pas exécuté correctement, il peut y avoir 
un risque pour la santé des personnes. En présence d'une mention AVERTISSEMENT, il 
convient de s'interrompre tant que les conditions ind iquées n'ont pas été parfaitement 
comprises et respectées.

Table 6 Description des Symboles de Sécurité qui pourraient apparaître sur le produit. (Sheet 1 of 2)

Symboles Description

Courant continu.

Courant alternatif.

Courant continu et alternatif.

Courant alternative triphasé.

Borne de terre (masse).

Borne de terre de protection.

Borne de terre reliée au cadre ou au châssis.

Borne au potentiel de la terre.

Equipotentialité

N Conducteur neutre sur un équipement installé à demeure

L Conducteur de phase sur un équipement installé à demeure.

Alimentation en marche.
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Alimentation à l'arrêt.

Alimentation en mode veille. Lorsque l'interrupteur est en mode veille, l'unité n'est 
pas complètement déconnectée de l'alimentation secteur.

Position Marche d'un interrupteur par bouton poussoir bi-stable.

Position Arrêt d'un interrupteur par bouton poussoir bi-stable.

Appareil entièrement protégé par DOUBLE ISOLATION ou ISOLATION RENFORCÉE

Attention. Consultez la documentation fournie.

Attention, danger d'électrocution.

Ne pas appliquer ou enlever sur des conducteurs SOUS TENSION DANGEREUSE

Application ou retrait autorisés sur les conducteurs SOUS TENSION DANGEREUSE

Attention, surface chaude

Rayonnement ionisant

CAT I Appareil de mesure decatégorie I selon la norme CEI applicable

CAT II Appareil de mesure de catégorie II selon la norme CEI applicable

CAT III Appareil de mesure de catégorie III selon la norme CEI applicable

CAT IV Appareil de mesure de catégorie IV selon la norme CEI applicable

Table 6 Description des Symboles de Sécurité qui pourraient apparaître sur le produit. (Sheet 2 of 2)

Symboles Description
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About Repetitive Strain Injury 64
Mice and Other Input Devices 65

To optimize your comfort and productivity, it is important that you set up your 
work area correctly and use your Infiniium oscilloscope properly. With that in mind, 
we have developed some setup and use recommendations for you to follow based 
on established ergonomic principles.

Improper and prolonged use of keyboards and input devices are among those 
tasks that have been associated with repetitive strain injury (RSI) to soft tissues in 
the hands and arms. If you experience discomfort or pain while using the 
oscilloscope, discontinue use immediately and consult your physician as soon as 
possible. For more information on RSI, read the “About Repetitive Strain Injury” 
section, next.

Please study the recommendations offered here in this chapter. Included are 
references to relevant parts of international standards, regulations, and guidelines, 
such as ISO 9241 and the European Community Display Screen Equipment 
directive. You may also consult your employer’s human resources department or 
other relevant departments for guidance specific to your company.
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About Repetitive Strain Injury

Because your comfort and safety are our primary concern, we strongly recommend 
that you use the Infiniium oscilloscope in accordance with established ergonomic 
principles and recommendations. Scientific literature suggests that there may be a 
relationship between injury to soft tissues—especially in the hands and arms—and 
prolonged improper use of keyboards or other equipment requiring repeated 
motions of the hands and forearms. This literature also suggests that many other 
risk factors may increase the chance of such injury, commonly called Repetitive 
Strain Injury.

What is RSI?

Repetitive Strain Injury (RSI—also known as cumulative trauma disorder or 
repetitive motion injury) is a type of injury where soft tissues in the body, such as 
muscles, nerves, or tendons, become irritated or inflamed. RSI has been a reported 
problem for those who perform repetitive tasks such as assembly line work, 
meatpacking, sewing, playing musical instruments, and computer work. RSI also 
has been observed in those who frequently engage in activities such as carpentry, 
knitting, housework, gardening, tennis, windsurfing, and lifting children.

What causes RSI?

The specific causes of RSI have not been established. Nevertheless, the incidence 
of RSI has been associated with a variety of risk factors, including:

• Too many uninterrupted repetitions of an activity or motion

• Performing an activity in an awkward or unnatural posture

• Maintaining static posture for prolonged periods

• Failing to take frequent short breaks

• Other environmental and psychosocial factors

In addition, there have been reports associating the occurrence of RSI with the use 
of keyboards, mice, and other input devices. Also, certain medical conditions, such 
as rheumatoid arthritis, obesity, and diabetes, may predispose some people to this 
type of injury.

What if I experience discomfort?

If you are experiencing any discomfort, seek professional medical advice 
immediately. Typically, the earlier a problem is diagnosed and treated, the easier it 
is to resolve.
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Mice and Other Input Devices

Various aspects of using mice and other input devices may increase your risk of 
discomfort or injury. Observing the following recommendations may reduce that 
risk.

• Try to keep your hand, wrist, and forearm in a neutral position while using your 
mouse or other input device.

• If you use your thumb to rotate the ball on a trackball or spaceball, keep it in a 
relaxed, natural shape, and maintain a neutral posture in your hand, wrist, and 
forearm.

• Hold the mouse gently by draping your fingers over it. Keep your hand relaxed 
and fingers loose. Do not grip the mouse tightly.

• It takes very little pressure or force from your fingers to activate the buttons or 
scroll wheel on your mouse, scrolling mouse, trackball, or other input device. 
Using too much force can place unnecessary stress on the tendons and 
muscles in your hands, wrists, and forearms.

• If you are using a scrolling mouse, be sure to keep your fingers and hand in a 
relaxed, neutral position when activating the scroll wheel. Also, this type of 
mouse features software that can minimize the number of mouse movements or 
button clicks.

• When using a mouse, trackball, or other input device, position it as close to the 
keyboard as possible, and keep it at the same level so you do not have to 
stretch while using it.

• Be sure to keep your mouse and trackball clean. Regular removal of 
accumulated dust and dirt helps ensure proper tracking and reduces 
unnecessary hand and wrist motions.
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Index

A

accessing
index, 52, 53
online help, 51

accessories
and options, 12

acquisition
starting and stopping, 36

adjusting
analog channel’s vertical offset, 41
analog channel’s vertical scaling, 41

airflow requirements, 14
application software, 22
associating measurement results with 

waveforms, 46
Autoscale, 21, 35
Aux Out,Cal Out, 19

B

back panel, 15
buttons, 31

C

calibration
output, 21

cautions
cleaning, 24

channel keys, 41
channels

turning on or off analog channels, 41
characteristics, 13
checking the oscilloscope, 12
cleaning the oscilloscope, 24
color

use of, 31, 46
configuration

default, 21
edge trigger, 43

configuring
quick measurements, 46

connecting
LAN card, 15
power, 16
probes, 17

contents
online help, 51

contents topic, 51
customizing display layout, 46
cycling

markers through channels, 47
measurements through channels, 46

D

default setup, 21
Default Setup key, 35
disk

hard disk recovery, 50
display layout

customizing, 46
display update rate

increasing, 41
drag-and-drop measurements, 46

E

edge trigger
setting, 43

environmental characteristics, 13

F

finding information, 51, 53
front panel

connections, 17
interface, 25, 31

H

hard disk
recovery, 50

horizontal
zoomed timebase, 38

horizontal position
in zoom mode, 38

I

icons
measurement, 46

increasing display update rate, 41
index

accessing, 52, 53
information

methods for accessing, 51
inspecting the oscilloscope, 12
installing

application software, 22

K

keys, 31
analog channel, 41
Autoscale, 35
Clear Display, 35
Default Setup, 35
Markers, 47
Multi Purpose, 46
Run, 36
Single, 36
Slope, 43
Source, 43
Stop, 36
Sweep, 43
Touch, 35
Zoom, 38

knobs, 31
analog channel’s vertical offset, 41
analog channel’s vertical scaling, 41
trigger level, 43

L

LAN card, 15
LED indicators, 31
level

trigger, 43



68 Infiniium Z-Series Oscilloscopes User’s Guide

Index
 

l ine voltage, 16

M

magnifying
a section of the waveform, 38

main timebase, 38
making

measurements, 46
quick measurements, 46
waveform bigger or smaller, 41

markers
and measurements, 46
moving, 47
positioning, 47
turning on or off, 47

measurement results
associating with waveform, 46

measurements, 46
and markers, 46
quick, 46
using markers, 47

methods for accessing information, 51
mouse

connecting, 15
verifying, 21

moving
markers, 47
waveform vertically, 41

Multi Purpose key, 46

N

navigating the online help, 53
notes

online help access, 51
online help windows, 52
zooming, 33

notices, 2

O

offset
adjusting analog channels, 41

online help
accessing, 51
index, 53
navigating, 53
overview, 51
windows, 52

opening the online help, 51

options
and accessories, 12

or, 35
oscilloscope

cleaning, 24
inspecting, 12
using, 25

oscilloscope front panel, 31
oscilloscope operation

verifying, 21
oscilloscope probes, see probes
oscilloscope won’t power on, 17
overdriving vertical amplifiers, 33

P

pointing device
connecting, 15
verifying operation, 21

pollution degree, 13
pollution degree, definitions, 13
position

adjusting analog channel’s vertical, 41
positioning markers, 47
power

connecting, 16
requirements, 16
turning off, 24

power supply protection features, 17
preset measurements, 46
probes

connecting, 17
probing a circuit, 17

Q

quick measurements, 46

R

Repetitive Strain Injury, 63, 64
using the mouse, 65

RJ-45 connector, 15
LAN card, 15

RSI, 63, 64
using the mouse, 65

Run key, 36

S

safety, 13

scaling
adjusting analog channel’s vertical, 41

seconds per division
in zoom mode, 38

setting
edge trigger, 43

setup
default, 21

Single key, 36
slope

trigger, 43
Slope key, 43
source

trigger, 43
Source key, 43
starting and stopping acquisition, 36
status indicators

trigger, 43
Stop

key, 36
sweep

key, 43
triggered, 43

T

topics
contents, 51
navigating, 53

tracking waveforms
using markers, 47

trigger
input coupling, 43
level, 43
setting edge, 43
slope, 43
source, 43
status indicators, 43

triggered sweep, 43
turning analog channels on or off, 41
turning markers on and off, 47

U

use of color in interface, 31, 46
user interface, 25

front panel, 31
use of color, 31

using
markers, 47
oscilloscope, 25
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V

verifying basic operation, 21
vertical inputs

overdriving, 33
vertical offset

adjusting analog channels, 41
vertical scaling

adjusting analog channels, 41
volts per division

adjusting, 41

W

waveform
magnifying, 38

waveform features
measurements on, 46
moving markers to, 47

waveforms
acquiring, 36
associating with measurement 

results, 46
drag-and-drop measurements on, 46
making quick measurements, 46
measuring using markers, 47
turning off, 41

window
zoom, 38

windows
online help, 52

Windows operating system settings, 23

Z

zoom display, 38
Zoom key, 38
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